Создание первого приложения на ASP.NET MVC 4
Создание проекта
Сейчас мы создадим первое примитивное приложение на mvc 4, которое призвано дать некоторое начальное понимание работы mvc. В качестве шаблона проекта мы выберем шаблон Empty и создадим мини-приложение с нуля.
Что будет делать наше приложение? Приложение будет представлять примитивную эмуляцию книжного магазина, в котором мы сможем просматривать список книг и оформлять покупку.
Итак, откроем Visual Studio или Visual Web Developer, в меню выберем File -> New Project.. и среди шаблонов проектов выберем шаблон ASP.NET MVC 4 Web Application и как-нибудь назовем новый проект, например, BookStore. Затем в окне создания нового проекта ASP.NET MVC 4 Web Application выберем шаблон Empty:
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После этого будет создан по сути пустой проект, в котором еще ничего нет. Нам предстоит наполнить его.

Во-первых, нам предстоит работать с данными, которые должны быть представлены некими моделями. Для нашей задачи мы можем выделить две области данных: информация о книге и информация, связанная с оформлением покупки. Соответственно, мы создадим две модели. Итак, в нашем приложении уже определена папка Models. В ней будут находиться наши модели. Нажмем на эту папку правой кнопкой мыши и в появившемся меню выберем Add->Class.... Назовем новый класс или модель Book и добавим в него код, описывающий модель книги:
namespace BookStore.Models
{
    public class Book
    {
        // ID книги
      
 public int Id { get; set; }
        // название книги
        public string Name { get; set; }
        // автор книги
        public string Author { get; set; }
        // цена
        public int Price { get; set; }
    }
}
Теперь таким же образом создадим класс для оформления покупки - класс Purchase:
using System;
namespace BookStore.Models
{
    public class Purchase
    {
        // ID покупки
        public int PurchaseId { get; set; }
        // имя и фамилия покупателя
        public string Person { get; set; }
        // адрес покупателя
        public string Address { get; set; }
        // ID книги
        public int BookId { get; set; }
        // дата покупки
        public DateTime Date { get; set; }
    }
}
Условности при создании моделей
В данном случае надо сказать, что в данном случае действуют некоторые условности. Поскольку база данных и соответствующая ей модель должна иметь первичный ключ (Primary Key), то мы его должны естественно определить. У нас есть два пути определения ключа. В данном случае мы использовали определение ключа по названию свойства. Для этого модель должна содержать свойство с именем Имя_моделиId или просто Id. Так, у нас в модели Purchase определено свойство PurchaseId, то есть данное свойство является первичным ключом. Второй способ состоял в определении ключа с помощью атрибута Key, установленным над нужным свойством. Более подробно об этом мы поговорим в главе, где будем обсуждать модели.
Создание контекста данных и EntityFramework
Для более удобного доступа к данным рекомендуется использовать фреймворк Entity Framework, хотя его использование необязательно и всецело зависит от предпочтений разработчика. Этот фреймворк позволяет абстрагироваться от структуры конкретной базы данных и вести все операции с данными через модель.
Поскольку мы создали проект по шаблону Empty, который практически не содержит никаких файлов, то нам надо будет добавить в проект файлы EntityFramework для взаимодействия с БД. Если бы мы создавали проект по другому шаблону, например, Basic или Internet Application, то библиотека EntityFramework уже была бы добавлена по умолчанию.
Итак, добавим в проект поддержку EntityFramework и для этого нажмем правой кнопкой мыши в структуре проекта на узел References (который содержит подключенные в проект библиотеки) и в появившемся меню выберем Manage NuGet Packages...
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В окне управления пакетами NuGet в правом верхнем углу введите в поле поиска Entity и нажмите Enter. После этого все найденные пакеты, которые имеют отношение к запросу, будут отображены в среднем столбце, как показано на рисунке:
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Затем устанавливаем пакет, и после того, как закончится установка, мы можем использовать все преимущества EntityFramework для управлением данными.
После установки создадим контекст данных. Он нужен для облегчения доступа к БД на основе некоторой модели. Добавим в папку Models новый класс BookContext со следующим содержанием:
using System;
using System.Collections.Generic;
using System.Web;
using System.Data.Entity;
  
namespace BookStore.Models
{
    public class BookContext : DbContext
    {
        public DbSet<Book> Books { get; set; }
        public DbSet<Purchase> Purchases { get; set; }
    }
}
Чтобы создать контекст, нам надо унаследовать новый класс от класса DbContext. Свойства типа public DbSet<Book> Books { get; set; } помогают получать набор данных определенного типа (в данном случае типа Book).
В итоге EntityFramework сам возьмет на себя заботу по созданию базы данных. То есть в данном случае мы будем использовать так называемый подход Code First - у нас есть модели, и по ним фреймворк будет создавать таблицы в базе данных.
[bookmark: _GoBack]Наконец, укажем строку подключения. Откроем файл web.config, найдем секцию configSections и после нее вставим секцию connectionStrings:
<connectionStrings>
    <add name="BookContext" connectionString="Data Source=(LocalDB)\v11.0;AttachDbFilename='|DataDirectory|\Bookstore.mdf';Integrated Security=True"
 providerName="System.Data.SqlClient" />
</connectionStrings>

Тем самым мы определяем путь к базе данных, которая потом будет создаваться. Выражение |DataDirectory| представляет заместитель, который указывает, что база данных будет создаваться в проекте в папке App_Data. Позднее мы подробнее разберем настройки подключения к БД.
Создание контроллера и представлений
Поскольку с моделями мы закончили, перейдем к наиболее важной части приложения - к контроллеру. Для контроллеров у нас уже имеется папка Controllers. Нажмите на нее правой кнопкой мыши и в появившемся меню выберите Add->Controller.... Перед вами появится диалоговое окно создания нового контроллера. Позже в соответствующей главе мы подробно поговорим о параметрах создания контроллерах да и о самих контроллерах, а пока установите в качестве имени контроллера HomeController и нажмите Add (Добавить)
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У вас будет создан следующий контроллер:
using System;
using System.Collections.Generic;
using System.Linq;
using System.Web;
using System.Web.Mvc;
 
namespace BookStore.Controllers
{
    public class HomeController : Controller
    {
        //
        // GET: /Home/
 
        public ActionResult Index()
        {
            return View();
        }
    }
}

Контроллер по сути и есть главное звено приложения, которая связывает модель и пользовательский интерфейс. Обратите внимание, что контроллер - это обычный класс, который наследуется от базового класса Controller. Он пока имеет единственный метод Index, который возвращает некоторый результат метода View() - будущее представление. И если мы сейчас запустим приложение, то получим ошибку о том, что представление для данного действия не определено. Но перед тем как добавить представление и приступить к созданию пользовательского интерфейса изменим метод Index следующим образом:
using System;
using System.Collections.Generic;
using System.Linq;
using System.Web;
using System.Web.Mvc;
using BookStore.Models;
  
namespace BookStore.Controllers
{
    public class HomeController : Controller
    {
        // создаем контекст данных
        BookContext db = new BookContext();
  
        public ActionResult Index()
        {
            // получаем из бд все объекты Book
            IEnumerable<Book> books = db.Books;
            // передаем все полученный объекты в динамическое свойство Books в ViewBag
            ViewBag.Books = books;
            // возвращаем представление
            return View();
      }
    }
}

Прежде всего, обратите внимание, что, так как у нас модели находятся в другом пространстве имен, хотя и в одном проекте, то мы его должны импортировать. Затем мы создаем контекст данных. Используя свойство Books, мы получаем из базы данных список объектов Book.
Далее мы создаем объект Books в объекте ViewBag и присваиваем ему этот список. Объект ViewBag является таким объектом, который передается в представление. И мы можем определить в этом объекте любую переменную и передать ей некоторое значение, а затем в представлении извлечь это значение.
А теперь создадим само представление. Наведем курсор на метод Index и нажмем правой кнопкой мыши. Нам отобразится меню, в котором выберем Add View....
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Затем нам откроется окно добавления представления, где нам будет предложено выбрать имя представления и еще ряд параметров. Поскольку у нас еще нет мастер-страниц в проекте, снимем галочку с флажка Use a layout or masterpage: и нажмем Add.
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Позже в соответствующей главе мы подробнее поговорим про опции создания и вообще про представления. А пока Visual Studio автоматически откроет созданное представление Index.cshtml. По сути оно пусто и содержит минимальный код разметки на языке html. Изменим его следующим образом:
{
    Layout = null;
}
  
<!DOCTYPE html>
  
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Книжный магазин</title>
</head>
<body>
    <div>
        <h3>Распродажа книг</h3>
        <table>
            <tr><td><p>Название книги</p></td>
                <td><p>Автор</p></td>
                <td><p>Цена</p></td><td></td>
            </tr>
            @foreach (var b in ViewBag.Books)
            {
            <tr>
<td><p>@b.Name</p></td>
                <td><p>@b.Author</p></td>
                <td><p>@b.Price</p></td>
                <td><p><a href="/Home/Buy/@b.Id">Купить</a></p></td>
            </tr>
            }
        </table>
    </div>
</body>
</html>

Здесь мы создаем таблицу, в которой будут располагаться наши данные о книгах. Особый интерес представляет конструкция @foreach (var c in ViewBag.Books). Эта конструкция использует синтаксис движка представления Razor (а именно его мы выбрали при создании представления). Подробнее мы погорим о движке Razor в отдельной главе, а пока вам надо знать, что после символа @ согласно синтаксису мы можем использовать выражения кода на языке C#.
В цикле мы пробегаемся по элементам в объекте ViewBag.Books, который мы ранее создали в методе контроллера. И затем получаем свойства каждого элемента и помещаем его в ячейку таблицы.
Ссылка в конце - <a href="/Home/Buy/@b.Id">Купить</a> будет означать адрес, по которому будет размещаться форма оформления покупки выбранной книги.
Основы маршрутизации
Чтобы вызвать контроллер HomeController или отправить ему запрос, нам надо указать в строке запроса его имя - Home. Кроме того, после имени контроллера нам надо через слеш указать действие или метод контроллера, к которому отправляется запрос. По умолчанию при запуске проекта или при обращении к сайту система mvc будет вызывать действие Index контроллера HomeController, если мы не укажем иной маршрут по умолчанию в параметрах маршрутизации. Путь /Home/Buy/@b.Id означает, что мы будем обращаться к методу Buy контроллера HomeController. Но перед тем как создать этот метод, наполним приложение данными.
Данные для моделей по умолчанию
Мы можем уже сейчас запустить наше приложение, однако кроме строки с заголовками в таблице мы ничего не увидим, потому что у нас же еще нет данных. Здесь мы могли поступить двумя способами: либо добавить в базу данных mssql некоторые данные, либо инициализировать начальные данные для моделей в коде. Выберем второй вариант. Для этого в папку Models добавим новый класс BookDbInitializer и добавим в него следующий 
using System;
using System.Collections.Generic;
using System.Linq;
using System.Web;
using System.Data.Entity;
  
namespace BookStore.Models
{
    public class BookDbInitializer : DropCreateDatabaseAlways<BookContext>
    {
        protected override void Seed(BookContext db)
        {
            db.Books.Add(new Book { Name = "Война и мир", Author = "Л. Толстой", Price = 220 });
            db.Books.Add(new Book { Name = "Отцы и дети", Author = "И. Тургенев", Price = 180 });
            db.Books.Add(new Book { Name = "Чайка", Author = "А. Чехов", Price = 150 });
  
            base.Seed(db);
        }
    }
}

С помощью данного класса мы создаем три объекта Book и добавляем их в базу данных. Чтобы этот класс заработал, нам надо не только его объявить, но и запустить. Все начальные настройки и конфигурации у нас хранятся в файле Global.asax. Откроем его и добавим в него в метод Application_Start, который отрабатывает при старте приложения, следующую строчку:
	
	Database.SetInitializer(new BookDbInitializer());



Ну и конечно, импортируем в файле Global.asax пространства имен [имя_проекта].Models и System.Data.Entity, иначе класс BookDbInitializer будет недоступен.
Все, теперь, если мы запустим приложение, то увидим, что в таблице содержатся ранее определенные нами данные:
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И если мы откроем папку проекта и зайдем в ней в каталог App_Data, то найдем только что созданную базу данных Bookstore.mdf, которая и будет хранить таблицы с данными.
Да, наша таблица выглядит немного неказисто, не мешало бы применить к ней стили, но не сейчас. Сейчас нам надо создать метод Buy, который будет отвечать за обработку ввода пользователя при оформлении покупки. Добавим в контроллер HomeController следующие два метода:
[HttpGet]
public ActionResult Buy(int id)
{
    ViewBag.BookId = id;
    return View();
}
[HttpPost]
public string Buy(Purchase purchase)
{
    purchase.Date = DateTime.Now;
    // добавляем информацию о покупке в базу данных
    db.Purchases.Add(purchase);
    // сохраняем в бд все изменения
    db.SaveChanges();
    return "Спасибо," + purchase.Person + ", за покупку!";
}

По сути здесь мы определили одно действие Buy, однако в одном случае оно выполняется при получении запроса GET, а во втором случае - при получении запроса POST, что мы и определили с помощью атрибутов [HttpGet] и [HttpPost]. Метод public ActionResult Buy(int id) очень прост - он просто принимает id выбранной книги и возвращает для нее соответствующее представление.
Метод public string Buy(Purchase purchase) выглядит несколько сложнее. Он принимает переданную ему в запросе POST модель purchase и добавляет ее в базу данных. В конце мы возвращаем строку сообщения.
И в конце добавим представление Buy. Для этого нажмем на метод public ActionResult Buy(int id) правой кнопкой и добавим в проект новое представление. Изменим код нового представления следующим образом:
@{
    Layout = null;
}
  
<!DOCTYPE html>
<html>
<head>
    <meta name="viewport" content="width=device-width" />
    <title>Покупка</title>
</head>
<body>
    <div>
        <h3>Форма оформления покупки</h3>
        <form method="post">
            <input type="hidden" value="@ViewBag.BookId" name="BookId" />
            <table>
                <tr><td><p>Введите свое имя </p></td>
                    <td><input type="text" name="Person" /> </td></tr>
                <tr><td><p>Введите адрес :</p></td><td>
                   <input type="text" name="Address" /> </td></tr>
                <tr><td><input type="submit" value="Отправить" /> </td><td></td></tr>
            </table>
/form>
    </div>
</body>
</html>

Здесь мы создали форму ввода данных. При переходе по ссылке "/Home/Buy/2" контроллер будет получать запрос к действию Buy. И так как такой запрос представляет тип GET, пользователю будет возвращаться форма. После заполнения формы и нажатия на кнопку форма будет оправляться запросом POST, так как мы его определили в строке <form method="post" action="">. Контроллер снова будет получать запрос к методу Buy, только теперь будет выбираться для обработки запроса метод public string Buy(Purchase purchase).
Каким образом система MVC угадывает, что мы передали с запросом post информацию о модели? Обратите внимание на поля ввода <input type="text" name="Person" /> и <input type="text" name="Address" />. Их свойства name соответствуют именам свойств модели Purchase. При нажатии кнопки и отправки запроса передаются значения этих полей. Система MVC, используя соглашения по умолчанию, считает эти значения значениями соответствующих свойств модели.
Теперь первое мини-тренировочное приложение готово, и мы можем его запустить. Перейдите на страницу оформления заказа, заполните поля и нажмите кнопку "Отправить".
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После этого ваша заявка на покупку книги попадет в базу данных, а в браузере отобразится соответствующее уведомление.
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А теперь добавим к нашему сайту элементы стилизации в виде стилей css, а также мастер-страницы, которые позволяют придать всем страницам сайта единообразный вид.
Стилизация приложения
Теперь в нашем приложении не хватает одной детали - стилизации. Сделаем какую-нибудь простенькую стилизацию. Для этого нам надо определить файл стилей для нашего приложения. Все файлы стилей принято хранить в папке Content, поэтому вначале добавим в проект папку Content. Для этого нажмем на название проекта правой кнопкой мыши и в появившемся меню выберем Add (Добавить)->New Folder (Новая папка).
Теперь в новую папку добавим файл стилей. Назовем его Site.css. Для этого нажмем правой кнопкой мыши на папку Content и в появившемся меню выберем Add (Добавить)->New Item (Новый элемент). Затем в списке шаблонов найдем шаблон Style Sheet и дадим новому файлу имя Site.css.
Теперь добавим в файл Site.css следующее содержание:
body {
    font-size: 13px;
    font-family: Verdana, Arial, Helvetica, Sans-Serif;
    background-color: #f7f7fa;
    padding-left:40px;
}
   
nav{
    display: block;
}
   
.menu {
    padding-left:10px;
}
.menu ul {
    list-style:none;
}
.menu li {
    display:inline;
}
.menu a:hover {
    color:red;
}
table {
   vertical-align:middle;
   text-align:left; 
 }
.header {
    font-weight:bold;
}
 td {
    padding-right:10px;
 }
input {
    width: 150px;
}

Класс .menu в данном случае будет служить в качестве класса для навигационного меню на сайте.
Теперь мы можем использовать стили. Поскольку наши представления по сути обычные веб-страницы, мы можем как и на любой странице html добавить в секции head ссылки на файл стилей:
<head>
    <meta name="viewport" content="width=device-width" />
    <link  type="text/css" rel="stylesheet" href="../../Content/Site.css" />
</head>

Если в приложении одно представление, или если разные представления используют разные стили и другие ресурсы, то такой подход оправдан. Однако в нашем случае у нас есть два представления, у которых должно быть одно меню и которые должны быть одинаково стилизованы. В этом случае очень удобно использовать мастер-страницы. Мастер-страница задает некий единый шаблон для других использующих его представлений.
Итак, создадим мастер-страницу. По сути это простое представление. Вначале добавим в папку Views проекта новую папку Shared. После этого в папку Shared добавим новое представление. Назовем его _Layout.cshtml:
[image: ]
Добавим в файл _Layout.cshtml следующий текст:
<!DOCTYPE html>
<html>
<head>
    <meta charset="utf-8" />
    <title>@ViewBag.Title</title>
    <link href="@Url.Content("~/Content/Site.css")" rel="stylesheet" type="text/css" />
</head>
  
<body>
    <nav>
        <ul class="menu">
            <li>@Html.ActionLink("Главная", "Index", "Home")</li>
        </ul>
    </nav>
    @RenderBody()
</body>
</html>

Здесь мы использовали другой способ подключения стилей - мы использовали метод Url.Content, в который передали путь к файлу. Оба способа - и этот, и использованный ранее равноправны.
Затем мы создали меню сайта с помощью методов Html.ActionLink, который генерирует элемент-ссылку и принимает название ссылки, метод контроллера и имя контроллера. В конце идет метод RenderBody(), при вызове ресурса в эту часть мастер-страницы и будут подставляться содержимое остальных представлений.
Теперь адаптируем представления к использованию их мастер-страницей. Изменим представление Index.cshtml следующим образом:
@{
    Layout = "~/Views/Shared/_Layout.cshtml";
}
    <div>
        <h3>Распродажа книг</h3>
        <table>
            <tr class="header"><td><p>Название книги</p></td>
                <td><p>Автор</p></td>
                <td><p>Цена</p></td><td></td>
            </tr>
            @foreach (var b in ViewBag.Books)
            {
            <tr>
                <td><p>@b.Name</p></td>
                <td><p>@b.Author</p></td>
                <td><p>@b.Price</p></td>
                <td><p><a href="/Home/Buy/@b.Id">Купить</a></p></td>
            </tr>
            }
        </table>
    </div>

Также изменим представление Buy.cshtml:
@{
    Layout = "~/Views/Shared/_Layout.cshtml";
}
  
    <div>
        <h3>Форма оформления покупки</h3>
        <form method="post" action="">
            <input type="hidden" value="@ViewBag.BookId" name="BookId" />
            <table>
                <tr><td><p>Введите свое имя </p></td>
                    <td><input type="text" name="Person" /> </td></tr>
                <tr><td><p>Введите адрес :</p></td><td>
                   <input type="text" name="Address" /> </td></tr>
                <tr><td><input type="submit" value="Отправить" /> </td>
                <td></td></tr>
            </table>
        </form>
    </div>

Сущность изменений состоит в том, что в секции Layout = "~/Views/Shared/_Layout.cshtml"; мы указываем путь к мастер-странице. После этого нам не нужны секции head и body. Запустив приложение, мы увидим, что теперь к нашему сайту применена стилизация:
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